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File structure: flat non-relational 
structure, up to 999 fields in a record, 
number of records in database limited 
only by storage medium

Data types: real, long integer, (date/1], 
fixed length and variable length text

Field Attributes: case insensitive 
searches, no range testing, no default 
values, no unique fields, no automatic 
incrementing fields, no calculated fields,

Data manipulation: Up to six indices 
at once, redefinable indexed fields, rede- 
finable file definition, (multiple record 
update or deletion)

Query facilities: Boolean expressions 
with up to six conditions, whole word 
and embedded substring with ? and * 
wild cards, case sensitive or not

Special features: (Multiple input 
formats), scripting for extensive report 
generating capabilities

Hardware: 256KIBM-PC and full 
compatibles, PC-DOS 2.0 and higher, 
printer recommended, color or 
monochrome screen

Other: No installation—only requires 
CONFIG.SYS with sufficient Files and 
Buffers set.

Sorting: Fast sorting using B-tree 
indexing. Uses up to 3 fields automati­
cally; uses 6 indices in the report 
generator

Input facilities: Fields have 20 charac­
ter labels, supports tab delimited text 
import files with column headers

Screen definition: Line oriented with 
up to 20 character labels and 56 charac­
ter fields (with hypertext variable 
length text fields)

Output facilities: Powerful script lan­
guage with automatic script generation 
for routine reports —single-line and 
multiple-line reports such as mailing 
labels. Report generator provides 
arithmetic functions, totals, subtotals,, 
average, count, min/max, etc. functions 
and sophisticated formatting. Sends 
output to screen, printer, or disk files; 
programmer accessible predefined script 
files for complicated or frequently used 
reports

Unique Features: Interface uses pull­
down and pop-up menus with scrolling, 
cursor selection of menu items, i.e., 
“point and shoot” even for template for­
matting and report generation; very 
rapid searches using B-tree indexing; 
designed for use by nonprogrammers

Potential Uses: Personal bibliographic 
retrieval system with interface to word 
processor for manuscript and thesis 
preparation; managing listed oriented 
data such as staff directories, room key 
lists and off-campus housing; capturing 
data from decentralized sources e.g, 
rapid creation of centralized databases 
such as telephone directory, accounting 
records, status of research projects, or 
even course registration; distribution of 
searchable database extracts such as li­
brary card catalog, course and room 
rosters, course catalogs, list of publica­
tions, advisee lists, employment 
opportunities with interview schedules, 
academic calendars, athletic and cultur­
al events, faculty research interests

[ 1 ] parentheses indicate planned additions
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Chapter 3

QuikBase™ Reference Guide
(DRAFT 12/07/88)

QUIKBASE™ provides rapid, yet simple, storage and retrieval of data—text and nu­
merical. This chapter presents a detailed description of the features and operation 
of QUIKBASE™. The distribution disk contains a file, DEMO, which is described in 
this chapter.

1.0 Features

QuikBase™ is a specialized database application for the IBM PC and workalike 
compatibles. The database handles as many records as your disk storage medium 
will accommodate. A record consists of up to 300 user-defined fields or entries) 
such as “Last name”, “First name”, “Street”, etc. Field types include: fixed length 
text where the input string is padded on the right with blanks to completely fill the 
field; variable length text where only the input string—without the trailing 
blanks—is stored, integer numbers, numbers without a decimal point and up to 10 
digits; real numbers, numbers which include a decimal point, and a date type of 
mm/dd/yy format.

File | Edit Sequence Report Import Template

Last name: Bartlett
First name: James
Institution: Cornell University

Street: 162 Riley Robb Hall
City: Ithaca
State: NY

Zip: 14853

<AltXN> Next record <PgDn> Next page <Right> Next character
<Alt><P> Previous record<PgUp> Previous page <Left> Previous character

A > r+ V
 

A
 > V Add record <Home> Top of screen <Del> Delete character

<AltXD> Delete record <End> Bottom of screen<Ins> Toggle insert mode
<AltXE> Edit menu <Down> Next field <Altxu> Undo string edit
<AltXS> Sequence menu <Up> Previous field <Backsp> Delete left
<AltXH> Toggle help /'<Home> Top of record ~<End> Bottom of record

Fig 3.1 Typical record input layout

Fig 3.1 illustrates the format of the input record layout. Each field has a text label 
of up to 12 right justified user-assigned characters; the contents of a field, which can
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have up to 56 characters, are left-justified on the same line of the display screen. 
When you create a database, i.e., a collection of records, you define the fields and 
the field labels. QUIKBASE™ allows you to make the inevitable changes to an exist­
ing database: add new fields before or after any existing fields, delete fields, modify 
the sequence of fields, and even change field types (with automatic translation).

Multiple databases can reside in a subdirectory. Data entry via keyboard is rapid 
and convenient. The input layout of Fig 3.1 provides access to all fields, but you can 
alter fields to which you have assigned the protected attribute only if you press ad­
ditional keys. {You can limit the number of fields displayed in the input layout to 
increase entry speed, to improve visual clarity, and to block designated fields from 
view for security reasons.}

A B-tree index gives you rapid access to stored data. With even very large databas­
es the program requires at most four disk accesses to locate any given record. You 
can define up to 10 indices at a time to facilitate rapid searches. A template menu 
provides keyboard control of customization of the contents of the records. You can 
modify the choice of fields, format, and placement of fields even after you have used 
the database, which provides an important degree of flexibility as usage of the data­
base expands.

Data manipulation capabilities include manual modification of records to modify the 
contents of a field by assignment and by adding and subtracting other fields. You 
can handle more sophisticated operations by exporting the data, performing calcula­
tions in a separate application such as a spreadsheet, and then importing the re­
sulting calculations. In addition a powerful script language permits you to custom­
ize calculations and reports. Limited assignments to previously defined fields allow 
you to record activities such as the mailing date of a brochure sent to the address of 
selected records. {To add: a few tools to modify contents of database.}

QUIKBASE™ provides report generation capabilities for the routine handling of tab­
ular data. You can produce two types of reports—one fine per record and multiple 
lines per record—and send them to the screen, to the printer, or to a file for subse­
quent use by programs such as a word processor. Sort and selection features allow 
you to order and filter records included in your reports. For example, you can pro­
duce a mailing list in zip code order. You can produced this as a text file or as a 
mail merge list for an individualized letter.

The one line per record format is convenient for producing quickly a paper trail.
The multiple line per record format provides more user control of the layout and al­
lows you to produce complete paper trails as well as create useful extracts of data. 
Use this option to produce mailing labels, too.
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2.0 Program organization

Simplicity of use is the 
overriding design criterion for 
QuikBa se ™ .

QUIKBASE™ is controlled from 
pop-down menus which are dis­
played across the top of the 
screen. The commands are ar­
ranged in the left-to-right se­
quence of normal use: access a 
file, edit records, revise the indi­
ces for sequencing records for 
rapid lookup of records, report 
generation and export of data 
via text files, import of data 
from text files, and revision of 
the template used for records. 
These menus make use of pop­
up submenus (Table 3.1) and 
edit windows. When display 
space permits, a reminder of the 
keystroke commands accompa­
nies each input window.

T ab le  3.1 Defaults
M e n u  c o m m an d s Page width 

Page length
F ile Left margin

About QB Report format
Database Single-line

File name Multi-line
Subdirectory Select/Sort

Path name Selection criteria
Quit Sort criteria 

Store format
E d it File name

First Retrieve format
>= record File name
<= record Generate Script
Last File name 

Generate report
S equ en ce

(create indices) Im p ort
File name

R e p o r t Append
Destination Merge

Printerl
Printer2 T em p la te
Screen (Field labels, field
Disk file type, field width)

BEFORE YOU BEGIN: Make a working copy of the distribution disk.
• Place a write-protect tab on the master diskette.
• Use the usual DOS commands to make a duplicate copy.
• Store the master distribution disk in a safe place.

Activate QUIKBASE™.

• After selecting the drive and subdirectory of QUIKBASE™, type QB and press 
<Enter>.

Note: Typographic convention: <Enter> means press the “Enter” key.

Use of menus
When the menu bar is active, type the first letter of a menu command or 
use the left and right cursor keys to highlight a menu name and press 
<Enter> to access the pop-down menu. To select a command from the 
menu, again type the first letter of the command or use the arrows to 
highlight a command and then press <Enter>. Press <Esc> to exit the 
menu and to return to the menu bar.
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QUIKBASE™ displays the copyright notices (Fig 3.2).

Q U I K B A S E ™  
The Quick Database

Database ©1989 Cooke Publications 
All Rights Reserved

NOTICE: THIS IS A PRELIMINARY 
NOT READY FOR PRODUCTIVE 

CONFIDENTIAL

VERSION.
USE

Fig 3.2 Copyright notices

You may need to adjust the screen brightness and contrast. QUIKBASE™ supports 
both monochrome and color screens.

Press any key to enter the File menu.

Note: General instructions in this manual are italicized and precede the detailed 
step-by-step instructions.

2.1 File Menu

The file menu allows you to select the database, including specification of 
the subdirectory. In addition, you create new database files here.

Select a database file. (DEMO in this example.)

QUIKBASE™ automatically presents the File menu when you activate the program 
(Fig 3.3).

However, if the program were already active, you would:

• Press <F> (or position the cursor on “File” and press <Enter>).

Fig 3.3 File menu
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The About QB command (Fig 3.4) contains acknowledgments.

About QuikBase™

The database software was produced 
at Cornell University by

J.Robert Cooke, Project Director, 
and

James V.Bartlett, Programmer,

using the B-Tree search index 
and report generation kernels 

published by FairCom of Columbia, MO.

Fig 3.4 About window.

Identify the subdirectory which contains the database files.

If the database DEMO is in a different subdirectory:

• Press <S> (or position the cursor on “Subdirectory” and press <Enter>).

File ____ Edit______ Sequence______ Report______ Import Template
About QB 
Database 
Subdirectory

Quit Subdirei :tory: C:\QB
Fig 3.5 Subdirectory designation

• Supply the letter for the disk drive, followed by a colon, and the path name in the 
submenu window. Follow the customary DOS conventions for naming files and 
specifying path names. In Fig 3.5 you type “C:\QB”.

• Press <Enter>.

In the example (Fig 3.5), the QB subdirectory on drive C has been specified. 
QUIKBASE™ and the data need not be located in the same subdirectory. Only one 
database can be open at a time.

The database consists of three files: DEMO.DAT (the data file of records), 
DEMO.DEF (the description of the format of the records), and DEMO.IDX (the file 
of indices). ALL THREE MUST BE PRESENT IN THE SAME SUBDIRECTORY. 
The “.IDX” file can be rebuilt by QUIKBASE™, but the “.DEF” file which contains 
the definition of the file structure cannot be regenerated.

Select the database.
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• Press “D” (or use the cursor arrows to highlight “Database” and press <Enter>).

Edit Sequence Report _____ Import______ Template
About QB 
Database
Subdir Database: DEMO
Quit

Fig 3.6 Database name

Enter the database name which can have up to eight (8) characters. No blanks and 
no file extension are allowed. The extensions for the three files are added by 
QUIKBASE™ . Lowercase letters are automatically converted into uppercase. Follow 
the rules for naming DOS files.

• Type the file name “DEMO” in any combination of upper or lower case letters and 
press <Enter>.

The name of the selected database appears in the status bar at the bottom of the 
screen (Fig 3.7). The name of the current index also appears in the status bar.

iilill Edit Sequence Report Import Template

Database: demo Sequence: Last name:
Fig 3.7 Status bar

To create a new file rather than to open an existing file, enter a file name not 
already in use in the current subdirectory. When you create a new file, you must 
first define the fields using the Template menu (§2.6) and then create at least one 
sequencing index using the Sequence menu (§2.3). These menus are described 
below.

2.2 Edit Menu

The Edit menu provides you rapid access to existing individual records 
and allows you to edit the contents of the fields of the records. In addition, 
you can delete old records and add new ones.

Locate a specific file and enter new data or modify the current contents of a record.

To edit the contents of records in the current database:
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• Press <E> (or position the cursor on “Edit” and press <Enter>).

File Edit Sequence Report Import Template
First 
>= record 
<= record 
Last

Fig 3.8 Edit menu

The pop-down menu allows you to move immediately to the first or to the last record 
by typing “F” or “L”. If you type “<“ or you can also begin editing at any record 
(Fig 3.9). Enter one or more leading characters corresponding to the current index 
(which is the Last name index in this instance and which is named in the submenu 
and at the bottom of the screen). Refer to the discussion of the Sequence menu for 
more detail.

• Press “>” and the submenu appears.

File 11||||^^0 Sequence Report Import Template
First 
>= record 
<= record 
Last

Fig 3.9 Search substring

• Type “Sm”, and the first record which matches the substring “Sm” appears.

In this case the first record which matches “Sm” as the first two characters in the 
File name index is found. Other records, e.g., Sue Smith or Sam Smythe, might fol­
low. Your search locates the first such match. See the discussion of the Sequence 
menu for additional information on the search order. Fig 3.10 displays the top of 
the record you just located. The field identifiers appear on separate lines and pre­
cede the contents stored in that field. Records can have up to 300 rows of informa­
tion. Scrolling commands provide access to the entire record. You can move the 
cursor to the top or to the bottom of the current screen or up or down a field at a 
time. Scroll commands also provide immediate access to the previous and next 
screen (or page) of information. If more than one screen of data exists, you can also 
move immediately to the first and last such pages of data.

Use the left and right cursor keys to move nondestructively within a field. You can 
delete the character highlighted by the cursor and the character to the immediate 
left of the cursor. New characters can either overwrite the existing characters or 
move all remaining characters to the right. An undo command allows you to restore 
the initial contents of a field.
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You can also add a new record or delete an existing record as well as access the next 
and previous records. The help window can be removed for a larger view of the ex­
isting record and restored only as needed.

Note 1: You must NOT set the NumLock key if you wish to use the cursor keys.

Note 2: The A symbol denotes the control key.

File : Edit Sequence Report Import Template

Last name: Bartlett
First name: James
Institution: Cornell University

Street: 162 Riley Robb Hall
City: Ithaca
State: NY

Zip: 14853

<AltXN> Next record 
<AltXP> Previous record 
<AltXA> Add record 
<AltXD> Delete record 
<Alt><E> Edit menu 
<AltXS> Sequence menu 
<Alt><H> Toggle help

<PgDn>
<PgUp>
<Home>
<End>
<Down>
<Up>
/v<Home>

Next page <Right> Next character
Previous page <Left> Previous character
Top of screen <Del> Delete character
Bottom of screen<Ins> Toggle insert mode 
Next field <Alt><U> Undo string edit
Previous field <Backsp> Delete left
Top of record A<End> Bottom of record

Fig 3.10 The edit menu and help reminders

• Press <AltxH> (i.e., press and hold “Alt” and then press “H”.) to remove or to re­
store the help screen. By removing the help information, you increase the maxi­
mum number of displayed lines from 11 to 20. If a record exceeds 20 lines, you can 
scroll to the next or to the previous page.

You can move the cursor to the top of the current screen to the bottom of the current 
screen, and to the first line or last line of the record even if that line is not currently 
displayed. The arrow cursor keys move the cursor to the next or the previous line if 
NumLock is not set.

Editing within a field also follows the usual word processor conventions: left and 
right arrows move the cursor left and right without erasing the contents. Character 
deletion is also provided. New characters typed in the field are either inserted with­
out deletion or overwrite existing characters as set by toggling the “ins” key. You 
can restore the original contents in a field with the “undo” command.

A summary of all QuikBase keystroke commands is included in the Appendix.

To leave the edit environment:
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• Press <Esc> to return to the menu bar or

• Press <AltxE> to return to the Edit menu or

• Press <AltxS> to set a different sequence index.

2.3 Sequence Menu

Use the sequence menu to create up to ten indices for record retrieval.

From the menu bar,

• Press <S> to enter the Sequence menu.

File Edit frequence Report Import Template

The sequence window (Fig 3.11) lists all the currently defined indices, in this case 
we have defined three indices. A help window automatically appears.

To select an existing index for record searches:

• Use the up and down arrows to select an existing index, e.g. Last name.

• Press <Enter> to accept the highlighted choice, and then

• Press “Esc” to exit.

To add, delete, or edit an index do the following:

To add an index,
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• Press <Alt><A>.

File Edit Sequence Report Import Template

An index window appears (Fig 3.12). Each index is composed of portions of up to 
three fields. The index establishes the sort order associated with the index. For ex­
ample, if you use Last name and First name, then the program creates an alphabet­
ical index for retrieval using the person’s name. The entries shown in Fig 3.12 
direct that the index be constructed from the first five characters of the last name 
and the first five characters from the first name. To create such an index:

• Move the cursor to Sequence #1 using the up and down arrows.

To move the cursor to the list of field names in the column at the left:

• Press <Enter>. A place holder identifies the current segment field when the cur­
sor moves to the list of field names at the left.

• Use the up and down arrows to highlight the field name you wish to use as the 
first segment of the index. Actually all the scrolling commands mentioned for the 
Edit menu (Fig 3.10)— <PgDn>, <PgUp>, <Home>, <End>, A<Home>, and A<End> 
apply.

• Press <Enter> to copy that file name to the field with the place holder.

• Repeat this process to select one or two more segments.

The index segments determine the retrieval order used in the edit menu. The first 
segment is the primary sort key. When the first segments match, the sort continues 
using the second segment, etc. However, you enter only the first segment in a 
record search.

When you have completed the index definition:
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• Press <Esc> to return to Fig 3.11. The name of the first segment becomes the 
name of the index although, in general, the index is based upon three fields.

To delete an index:

• Use the cursor to highlight the name of the index (Fig 3.11) and press <AltxD>. 

To edit an index:

• Use the cursor to highlight the name of the index (Fig 3.11) and press <AltxE>. 
Follow the instructions described for “Add”.

Once you have added, deleted, or edited the list of indices, return to the Sequence 
menu and select the “current” index.

• Use the up and down cursor keys to highlight an index.

• Press <Enter> to designate the highlighted index name as the current index.

• Press <Esc> to leave the Sequence menu and return to the main menu bar.

2.4 Report Menu

Use the Report menu to extract reports from the current database. You 
can send output to the screen, to either printer port, or to a file. The re­
port format can be single-line, i.e., organized by “columns” with one record 
per line, or multi-line, i.e., page oriented with multiple lines of output 
from a record per page. You define a Boolean record selection criterion 
and specify the sort order of the output. You can produce frequently used 
reports from a collection of script files. Reports which are a variation on a 
theme are easily constructed from saved formats.

File Edit Sequence Import Template
Destination 
Defaults 
Report format 
Select/Sort 
Store format 
Retrieve format 
Generate script 
Generate report

Fig 3.13 Report menu

The Report menu (Fig 3.13) contains eight commands which define the report for­
mat and contents. You can send output to the screen, to printer ports 1 and 2, or to 
a text file (Fig 3.14). Use the “point and shoot” method to select the destination.



QuikBase™ Wednesday, December 7,1988 3-12

In other words:

• Use the up and down cursor to highlight a choice. Then

• Press <Enter> to select the highlighted option.

QUIKBASE™ returns you to the Report menu and the destination remains set until 
you explicitly modify it. You can examine and modify text files using a standard 
word processor or editor. Certain exported files can be read by QUIKBASE™.

File Edit Sequence Report?:’; Import Template
Destination 
Defaults 
Report f 
Select/S 
Store fo 
Retrieve 
Generate 
Generate

Fig 3.14 Destination submenu

• Set Defaults (Fig 3.15) for page width, page length, and the number of characters 
reserved for the left margin. These need not be set for screen output. •

Printerl 
Printer2 
Screen 
Disk file
script
report

File Edit Sequence ? Report Import Template

Destination
Defaults
Repc Page width: 80
Sele Page length: 66
Stor Left margin: 0
Retrieve format 
Generate script 
Generate report

Fig 3.15 Defaults submenu

• Press <Esc> to return to the Report menu.

• Use Report format (Fig 3.16) to choose one of the standard report formats: Single- 
line or Multi-line using the “point and shoot” method.
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File Edit Sequence Report Import Template

Destination 
Defaults 
Report format
Select/S Single-line
Store fo Multi-line
Retrieve
Generate
Generate

format
script
report

Fig 3.16 Report format submenu

A. Single-line Report:

The single-line or “column format” is the simpler—QUIKBASE™ displays the fields 
you select “in columns” with all fields for a particular record on a single line. A tele­
phone directory is an example of this style report. After you select “Single-line” (Fig 
3.15), a window for report definition appears (Fig 3.17).

File Edit Sequence Report Import Template

Last name: 
Institution: 
Street:
City:
State:
Zip:

Header: Labels

Labels: None

Alignment: Field width

Page breaks: on

Report width : 133

Last nam^First name^Street addressJcitj^Stat^Jzip code

Fig 3.17 Single-line report definition 

You can make choices in any order.

Select fields for the single-line report.

• Use the left arrow to move the cursor to the list of field names on the left.
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• Use the “point and shoot” method to highlight and choose a field.

• Repeatedly use the “point and shoot” method to select the additional fields you 
wish to include in the report. If the list of database field names exceeds 20, use the 
up and down arrows to scroll the list into view.

The list of selected names appears at the bottom of the screen separated by delimit­
ers. Since the length of a field need not match the length of the field name, 
QUIKBASE™ displays a running total for the report line width in the largest window 
(Fig 3.17).

• Use the right arrow to move the cursor back into the largest window.

Note: Use <Alt> <D> to delete an entry for the currently highlighted field label.

By toggling you can make choices in the four remaining categories.

• Use the up and down arrows to move the cursor to each of the four catego­
ries—headers, labels, alignment, and page break.

• Use the space bar to cycle among the available choices (Fig 3.17).

Header choices for the report are:

1) Labels: use field labels as column headings. If necessary, QUIKBASE™ truncates 
the labels to conform to field width.

2) Symbols', uses stylized field names to match the requirements of the report gener­
ator and for subsequent importing of the data. QUIKBASE™ uses only alphabetic, 
numerals and underscores. Underscores replace spaces.

3) None: no header is produced.

Field label choices immediately precede the contents of each field value and unique­
ly identify the values:

1) Labels: the field precedes each field value in the report.

2) Symbols: a stylized field name precedes each value.

3) None: no label precedes each field value.

Alignment choices control the spacing of the fields:

1) Field width: QUIKBASE™ pads the field on the right with spaces to preserve ver­
tical alignment of the fields.

2) Tab separated: QUIKBASE™ places a tab character between fields.
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3) Space separated: QUIKBASE™ places a space character between fields.

You can provide more specialized formatting by editing the script file. See the 
Appendix.

After making these choices or accepting the defaults:

• Press <Esc> to return to the Report menu.

• Use the “Generate script” command to create a script file and “Generate report” to 
generate the report (Fig 3.13 and 3.16), and send all records in physical storage 
order to the output destination chosen earlier. See the discussion of the 
“Select/Sort” command below to print only records which meet certain qualifications 
and to control the ordering of the records in the report.

B. Multi-line Report

The multi-line report format is slightly more complicated—the fields you select are 
displayed in multiple lines. A mailing label is an example of this style report. After 
you select “Multi-line” (Fig 3.15), a window for report definition appears (Fig 3.18).

File Edit Sequence us.o in II Import Template

Labels: None Alignment: Field width

Fig 3.18 Multi-line report format 

You can make the choices in any order.

Select fields for the multi-line report.
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Use the grid (Fig 3.18) to specify the sequence of fields you want to display on each 
row. The Labels and Alignment options discussed below control the actual print po­
sitions within the rows.

• Use the four cursor arrows to select a position within the grid (Fig 3.18).

• Press <Enter> to select that highlighted position within the grid, a list of field 
names pops-up at the left, and the cursor moves into the fist of field names. * •

File Edit Sequence Report Import Template

Last name: 
Institution: 
Street:
City:
State:
Zip:

Alignment: Field width

Fig 3.19 Field selection for page oriented report
"V

Use the up and down arrows to highlight a field name.

If the list of database field names exceeds 20, use the up and down arrows to scroll 
the list into view.

• Press <Enter> to select the highlighted field.

QUIKBASE™ copies the selected field name to the position marked by the place hold­
er and highlights it.

• Repeat the previous four steps to assign other fields.

By toggling you can make two remaining choices.
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• Use the up arrow to move the cursor to the top row— labels and alignment— and 
use the left and right arrows to move between the two categories.

• Use the space bar to cycle among the available choices (Fig 3.18).

Field labels immediately precede the contents of each field value and can be used to 
uniquely identify the values (as with Column reports):

1) Labels: the field precedes each field value in the report.

2) Symbols: a stylized field name precedes each value.

3) None: no label precedes each field value.

Alignment choices control the spacing of the fields:

1) Field width: QUIKBASE™ pads the field on the right with spaces to preserve ver­
tical alignment of the fields.

2) Tab separated: QUIKBASE™ places a tab character between fields.

3) Space separated: QUIKBASE™ places a space character between fields.

After making these choices or accepting the defaults:

• Press <Esc> to return to the Report menu.

If you wish to generate similar, but slightly different, report

• Use the Store format command described below.

To use the just designed format:

• Invoke the “Generate report” command (Fig 3.13 and 3.16) to send all records in 
physical storage order to the output destination chosen earlier.

See the discussion of the “Select/Sort” command to print only records which meet 
certain qualifications and to control the ordering of the records in the report.

Selection and sorting of records in the report

The final step before you generate the report is the selection of the records you want to 
include in the report and designation of a convenient sequencing of the records.

From the Report menu (Fig 3.13)

• Highlight “Select/Sort” and press <Enter>.

The screen (Fig 3.20) now contains three windows: a list of the field names, six
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Boolean selection conditions, and six fields for designating the sorting sequence. 

Selection criteria

Note: Leave the Selection criteria window blank to include all records in a search.

• If the cursor is not at Field Name 1, use the cursor arrows to highlight this entry.

• Press <Enter> to move the cursor into the fist of fields.

File Edit Sequence S&epojrfc <•' Import Template

• Use the up and down arrows to highlight a field name. If the list of field names is 
long, you may need to scroll the list with the arrow keys or use the other scrolling 
commands (Fig 3.1).

• Press <Enter> to select the highlighted field name.

QUIKBASE™ copies the field name to the select window.

• Use the right arrow to move the cursor from the selected field name to the 
Boolean operator. •

• Repeatedly press the space bar to toggle among the six comparison operators:
= equals; <> not equal to; < less than; <= less than or equal to; > greater than; >= 
greater than or equal to.
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With the desired comparison showing,

• Use the right arrow key to move the cursor to the field value.

• Type a valid value of the same type as the field type (real, integer, string).

Note: You can use the DOS wildcard characters “*” and “?” with “=” and “<>” com­
parisons . For example, *son* matches strings with the substring “son” embedded, 
e.g., Donaldson, Dyson, as well as Sondheim, while *son would exclude the last 
name; and son* would exclude the others. Dys?n would match both Dyson and 
Dysen, but not Donaldson.

• Use the right arrow to move the cursor to the last column.

• Use the space bar to toggle among “END”, “AND”, and “OR”.

If you are going to apply an additional condition in line 2, choose either “AND” or 
“OR”, as appropriate. On the other hand, if this line concludes the Boolean expres­
sion, select “END”.

Note: QUIKBASE™ groups each of the numbered lines by an implicit set of parenthe­
ses.

The example in Fig 3.20 locates all records of persons having first name James, ex­
cept those with last name Bartlett.

Sort the selected records

After completing the selection criteria:

• Use the down arrow to move the cursor to field 1 in the “Sort by” window (Fig 
3.20).

• Press <Enter> to move to the list of field names.

• Use the up and down arrows to highlight a field.

• Press <Enter> to select a field and copy the field name to the sort window.

You can choose up to six sort keys for the records. The order of selection is impor­
tant. For example, if you were producing a set of mailing labels, you would chose 
Zip code first, Last name second, and First name third to produce a zip code ordered 
list with names alphabetized with each zip code. •

• Press <Esc> to return to the Report menu after you have specified the selection 
and sort criteria.

Store format

This command saves a QUIKBASE™ editable report configuration.
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If you wish to explore several similar report formats:

• Use Save format (Fig 3.21) to save the complete set of existing format, selection, 
and sort choices.

Then for subsequent iterations simply:

• Use Retrieve format described below to reinstate all the save choices.

In other words, the save condition become the starting point for the report design.

File Edit Sequence Import Template

Destination 
Defaults 
Report format 
Select/Sort 
Store format 
Retrieve format 
Generate script 
Generate report

Retrieve format

This command allows you to retrieve a previously saved report description.

You can either:

• Use the retrieved format (Fig 3.21) to generate a report or

• Modify the report description before generating a report.

QUIKBASE™ supplies the file extension “.FMT”.

Generate Script

This menu command automatically transforms the report specifications you entered 
above into a report generator script.

Script files can be re-used to produce your standard reports. You cannot edit these 
script files from within QUIKBASE™, but you can modify these text files using a 
word processor or text editor if you know the syntax.
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• Supply the name of the script file (Fig 3.22). QUIKBASE™ supplies the file exten­
sion “.SCR” .

• Press <Esc> when ready.

File Edit Sequence lilillliP: Import Template

Destination 
Defaults 
Report format 
Select/Sort 
Store format 
Retrieve format 
Use Script 
Generate report

Generate Report

This command of the Report menu generates the report according to the script file 
generated above and sends the report to the designated output device.

You must supply the name of the script file. QUIKBASE™ automatically presents 
the name of a just-completed script as the default; simply press <Enter> to accept 
the default.

2.5 Import Menu

This menu provides a capability for transferring data from a text file into 
QuikBase™.

For example you can transfer obtained from a centralized database into 
QUIKBASE™ and use them to produce mailing labels, track responses and to moni­
tor the records through the completion of the admission process. You can append 
records to the end of an existing list (which might have no records yet) {or assign 
values to selected fields from an import file}. In this case, you must specify a field 
you want QUIKBASE™ to use to make an unambiguous match of records.

To enter the Import command:

• Press “I” (or use the arrows to highlight Import and press <Enter>).
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• Select File name to name the import file (Fig 3.23).

If a properly prepared file exists:

• Enter the file name and press <Enter>.

File Edit Sequence Report ' Import Template

File name
Append
Merge

Fig 3.23 Import menu
Format of import files.

What is a properly prepared file? QUIKBASE™ imports standard text files IF:

1) the fields of a record are tab-delimited,

2) the record is delimited by carriage returns, and

3) the first record consists of stylized field labels to identify the fields. These labels 
must match exactly the the corresponding field label to which you are assigning the 
data.

You can obtain an exact rendering of this header information by creating a text file 
using the following options of the Report menu: Destination: Disk file (Fig 3.13); 
Report format: Single-line (Fig 3.16) with (Fig 3.17) Header: Symbols; Labels: 
None; Alignment: Tab separated; with the desired fields selected (Fig 3.17) and a 
record selection criterion (Fig 3.20) which includes no records.

2.6 Template Menu

The template command allows you to define and redefine the fields. You specify field 
names, field type (real, integer, fixed length string, or variable length string) and 
maximum field lengths.

For a new database,you must define the template immediately after you 
name the database. Then you must define at least one index sequence 
(Using the Sequence menu) to produce a usable database.
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From the menu bar:

• Press <T> (or use the cursor keys to highlight Import and press <Enter>. 

The template window (Fig 3.24) appears.

File Edit Sequence Report Import template 1

TemplateEdit — Template help
Label Type Width
Last name: 4 20 A<V

 
A

 
+Ji—

1 
<V Add field at current row

Institution: 4 50 <AltXZ> Add field after current row
Street: 4 50
City: 2 20 A > H ft V

 
A

 
O V Delete current field

State: 2 12
Zip: 2 12 <AltXN> Move field to next row

<AltXP> Move field to previous row

<Tab> Horizontal cursor movement
<Up>,<Down> Vertical cursor movement
<PgUp>, <PgDn>, <Home>, <End>
<CtrlXHome>, <CtrlXEnd>

Legal Field types
1. Integer field (4 bytes)
2. Fixed length text field
3. Floating point field (4 bytes)
4. Variable length text field

Maximum field width = 56
Fig 3.24 Template window

The window on the left (Fig 3.24) shows the structure of the current database. A 
reminder of the keystroke commands is displayed at the right. The cursor controls 
are the same as described above.

To add a new field:

• Highlight a field name using the up and down arrows.

• Use <AltxA> to add a field at the position of the highlighted field and move all 
subsequent fields down or •

• Use <ALTxZ> to add a field at the position just below the highlighted field and 
move all subsequent fields down.

To delete a field:

• Highlight the field to be deleted using the cursor keys.
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• Press <AltxD>.

The addition or deletion of a field requires QUIKBASE™ to restructure the database 
file. The time for this depends upon the size of the database.

To move fields:

• Highlight a field name using the up and down arrows.

• To move a highlighted field down, use <AltxN>

• To move a highlighted field up, use <ALTxP>.

Note: You can use blank lines to separate groups of fields into logical clusters.

For each field in the database you must specify:

a) display label (for user information only— up to 20 characters)
b) field type

1. Integer field of length (4 bytes)
2. Fixed length text field (up to 56 characters)
3. Floating point field (4 bytes)
4. Variable length text field (up to 56 characters)

c) field width.

Only the variable length text field varies in length according to field contents.

Simply rearranging the sequencing of fields does not require QUIKBASE™ to modify 
the entire file.

To leave the template window:

• Press <Esc>.

If you have made substantive changes (i.e., added fields, deleted fields, changed 
field types or field widths), QUIKBASE™ must rebuild the database. Minor changes 
such as field labels and field sequencing do not require that the database be rebuilt.

QuikBase must create a backup of the old database before changes are 
made (Fig 3.24). Note: Making a backup file is also an appropriate 
security step.

—



QuikBase™ Wednesday, December 7,1988 3-25

File Edit Sequence Report Import

Edit Template
Label Type Width 
Last name: 4 20

Template help

<AltXA> Add field at current row
Ins row
Sti The current database must be rebuilt to accommodate changes
Cit in the database template.
Sta
Zip Backup database name:

row

ment

s)

Maximum field width = 56
Fig 3.25 Rebuilding the database due a changed file structure

Terminate a session

If not already at the menu bar level:

• press <Esc> to reach that point.

• Press <F> to enter the File menu.

• Press <Q> to quit QUIKBASE™.
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Appendix 
Key com m ands

<AltxA> Add field, index, record
<AltxD> Delete current field, index, record
<AltxE> Edit index, menu
<AltxH> Toggle help
<AltxN> Move field to next row
<AltxN> Next record
<AltxP> Move field to previous row, 

move to previous record
<AltxS> Sequence menu
<AltxU> Undo string edit
<AltxZ> Add field after current row
<Backsp> Delete left
<CtrlxEnd> Scroll to end
<CtrlxHome> Scroll to beginning
<Del> Delete character
<Down> Next field, index, cursor down
<End> Bottom of screen
<Enter> Accept current value
<Esc> Exit, return to previous level
<Home> Top of screen
<Ins> Toggle insert mode
<Left> Previous character
<PgDn> Next page
<PgUp> Previous page
<Right> Next character
<Tab> Horizontal cursor movement
<Up> Previous field, index, cursor up
A<End> Bottom of record
A<Home> Top of record
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Sample Script Files

Single-line Report

Suppose you wish to prepare a one-line per record style report such as the following:

Last-name First-name Street-address City_______ State
Cooke J. Robert 214 Riley-Robb Hall Ithaca NY
Bartlett James 162 Riley-Robb Hall Ithaca NY

QUIKBASE™ automatically generates the following script file, which controls the 
preparation of the report. You need only provide the required information via the 
menu commands on the Report menu. Ordinarily, therefore, you need not be con­
cerned with this step. However, you can exercise additional control over the report 
by making changes to the script file. This example illustrates the structure of such 
files.

/*

Last_name
First_name
Street_address
City
State
*/
START

SEARCH
FILE "DEMO.DAT" ALL

SELECT
ALL

DISPLAY
DEVICE 1
PAGE_WIDTH 132
PAGE_LENGTH 6 6
LEFT_MARGIN 0

IMAGE
PAGE_HDR

+Last-name First-name Street-address City State
+--------  --------- -------------------- ---------  ------
BODY

+ 0 X X X X X X X X X  @ X X X X X X X X X X X  6 X X X X X X X X X X X X X X X X X X  0 X X X X X X X X X  @ x x x x x x x

Last_name First_name Street_address City State 

EXIT

The script begins with a comment delimited by /* and */ which lists the labels in 
symbol form, i.e., with spaces replaced by underscores and only alphanumerics as
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characters. The key START indicates the beginning and EXIT closes the script.
The search file is named and all records in the file are to be included. The display is 
to be sent to printerl which has width of 132 characters, 66 lines per page and the 
left margin has no offset. The image has literal headers shown on the lines which 
begin with plus signs. The field templates also have an initial plus but individual 
fields begin with the @ symbol and are separated by spaces. The “x”s are place hold­
er templates for the field values identified just below that line. The “x”s indicate 
the maximum field width which will be padded on the right with space characters 
as needed. “v”s indicate no padding is to be added.

Multi-line Reports

A mailing label example illustrates additional commands. Suppose you wish to pro­
duce the following report:

J. Robert Cooke 
214 Riley-Robb Hall 
Ithaca NY

James Bartlett 
162 Riley-Robb Hall 
Ithaca, NY

/*

Last_name
First_name
Street_address
City
State
*/
START

SEARCH
FILE "DEMO.DAT" ALL

SELECT
ALL

SORT USING KEY
UPPER Last_name

DISPLAY
DEVICE 1
PAGE_WIDTH 80
PAGE_LENGTH 5
LEFT_MARGIN 10

IMAGE
BODY

+@
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+First_name Last_name
+@------------------
Street_address
+@---------  ------
City State 
PAGE_BREAK

EXIT

In this example the names have been sorted by the Last name label, although you 
would normally sort by the Zip code label. The page length is shorter and a left 
margin was used to match the label spacing. The body of the report includes multi­
ple lines. Each record is followed by a page break.


